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1 Общие сведения

В данном документе рассматривается процесс сборки и запуска программы теста производительности пе-
редачи данных по шине SRIO (Serial RapidIO) между двумя модулями SAMC-403.

Предполагается, что в тестовой системе установлен центральный коммутатор SMCH-100-SRIO12 производ-
ства компании Scan Engineering Telecom в состав которого входит SRIO коммутатор, выполненный в виде
двух микросхем TSI578.

Схема соединения двух модулей SAMC-403 через коммутатор SMCH-100-SRIO12 показана на рисунке 1-1.
Программа теста производительности запускается на обоих модулях SAMC-403. На модуле SAMC-403 #1
запускается программа consumer (приемник трафика), на модуле SAMC-403 #2 запускается программа
producer (генератор трафика). После запуска программ на обоих модулях SAMC-403 программа producer
передает данные по шине SRIO программе consumer на втором модуле SAMC-403. Во время передачи
происходит замер скорости передачи данных.

Рисунок 1-1: Схема соединения модулей SAMC-403 через коммутатор SMCH-100-SRIO12

Для сборки и запуска программы теста производительности потребуется установленная система разработ-
ки CCS (Code Composer Studio). Сборка и запуск программы были проверены на CCS версии 5.2.0.00069
под Windows систему. Дистрибутив CCS версии 5.2.0.00069 для Windows и Linux систем можно найти на
сопроводительном диске к модулю SAMC-403 в папке «software/ccs».

Код программы теста производительности написан на основе кода, входящего в состав библиотеки TI PDK
для процессоров C6678.
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2 Конфигурация

Программа теста производительности SRIO состоит из двух проектов: для приемника данных (consumer)
и для генератора данных (producer). Исходные коды обоих проектов находятся на сопроводительном
диске к модулю SAMC-403 в папке «srio/benchmark». Папка «srio/benchmark» содержит две подпап-
ки: «SRIO_TputBenchmarkingTestProject-Cons» и «SRIO_TputBenchmarkingTestProject-Prod» для приемника
данных и генератора данных соответственно. Далее, предполагается, что папка с проектами теста произ-
водительности «benchmark» с сопроводительного диска была переписана на жесткий диск компьютера в
папку «D:/SRIO».

Перед сборкой проекта необходимо выполнить конфигурацию программы теста производительности путем
редактирования файла «benchmarking.h» в каждом из проектов.

2.1 Конфигурация скорости линий SRIO
Скорость линий SRIO устанавливается макроопределением «SRIO_LANE_SPEED» в файле
«benchmarking.h» (строка 97) обоих проектов теста производительности. Возможные значения пара-
метра приведены в таблице 2-1.

Таблица 2-1: Возможные значения макроопределения «SRIO_LANE_SPEED»

Значение Скорость
srio_lane_rate_1p250Gbps 1.25 Гбит/с

srio_lane_rate_2p500Gbps 2.5 Гбит/с

srio_lane_rate_3p125Gbps 3.125 Гбит/с (значение по умолчанию)

srio_lane_rate_5p000Gbps 5.0 Гбит/с (не поддерживается коммутатором SMCH-100-SRIO12)

Выполняя конфигурацию скорости линий SRIO в программе теста производительности необходимо, также,
конфигурировать коммутатор SMCH-100-SRIO12 соответствующим образом. Конфигурация скорости линий
SRIO на коммутаторе SMCH-100-SRIO12 выполняется с помощью 4-х позиционных переключателей S3 и
S5 на плате коммутатора. Описание значений этих 4-х позиционных переключателей описано в таблице А-1
(приложение А).

2.2 Конфигурация режима линий SRIO
Режим линий SRIO устанавливается макроопределением «SRIO_PORT_WIDTH» в файле «benchmarking.h»
(строка 103) обоих проектов теста производительности. Возможные значения параметра приведены в таб-
лице 2-2.

Таблица 2-2: Возможные значения макроопределения «SRIO_PORT_WIDTH»

Значение Режим
srio_lanes_form_four_1x_ports Четыре 1х порта

srio_lanes_form_2х_port_and_two_1x_ports Один 2x порт и два 1х порта

srio_lanes_form_1х_port_and_one_2x_ports Два 1x порта и один 2х порт

srio_lanes_form_2x_ports Два 2x порта

srio_lanes_form_4x_port Один 4x порт (значение по умолчанию)
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2.3 Конфигурация SRIO идентификаторов устройств
Так как маршрутизация SRIO осуществляется основываясь на уникальных идентификаторах устройств, то
для правильной работы теста производительности необходимо их правильно сконфигурировать. В случае
использования коммутатора SMCH-100-SRIO12, идентификатор устройства будет зависеть от того, в ка-
кой AMC-слот шасси это устройство будет установлено. Соответствие идентификаторов с номерами AMC-
слотов приведено в таблице А-5 (приложение А).

Идентификаторы устройств генератора данных и приемника данных теста производительности SRIO уста-
навливается макроопределениями «PRODUCER_8BIT_DEVICE_ID» и «CONSUMER_8BIT_DEVICE_ID» в
файле «benchmarking.h» (строки 190 и 195) обоих проектов теста производительности. Макроопределе-
ние «PRODUCER_8BIT_DEVICE_ID» задает идентификатор для устройства на котором будет запускаться
программа генератора данных. «CONSUMER_8BIT_DEVICE_ID» задает идентификатор для устройства на
котором будет запускаться программа приемника данных.
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3 Сборка теста производительности

Для сборки проекта теста производительности необходима установленная библиотека TI MCSDK. Сборка
проекта была проверена с библиотекой MCSDK версии 2.00.08.20, дистрибутив которой имеется на сопро-
водительном диске к модулю SAMC-403 в папке «software/ccs/mcsdk».

Для сборки проекта в CCS необходимо импортировать в среду разработки и собрать два проекта теста про-
изводительности. Работа с каждым проектом теста производительности должна производится в отдельном
рабочем пространстве (workspace).

3.1 Сборка проекта приемника (consumer)
3.1.1 Создание рабочего пространства

Для создания нового рабочего пространства, в запущенной среде разработки CCS, выберите пункт меню
«File > Switch Workspace > Other...» (рисунок 3-1).

Рисунок 3-1: Смена рабочего пространства (workspace) в CCS

В открывшемся окне (рисунок 3-2) выберите папку нового рабочего пространства. Например, можно исполь-
зовать папку «D:/SRIO/Workspace_Cons».

Нажмите на кнопку «OK». Среда CCS будет перезапущена с новым рабочим пространством. После запуска
можно будет увидеть окно, аналогичное показанному на рисунке 3-3.
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Рисунок 3-2: Выбор папки для рабочего пространства (workspace) в CCS

Рисунок 3-3: Главное окно среды CCS после запуска в новом рабочем пространстве

3.1.2 Импорт проекта

Нажмите на кнопку «Import Project» (на рисунке 3-3 выделено красным овалом). Откроется окно, показанное
на рисунке 3-4.

Примечание

Окно импорта проектов, показанное на рисунке 3-4, можно вызвать через главное меню, выбрав пункт «File > Import...». В
открывшемся окне выбора типа проекта, нужно выбрать тип «Code Composer Studio > Existing CCS Eclipse rojects» и нажать
на кнопку «Next > ».

Нажмите на кнопку «Browse...». Откроется стандартное системное окно обзора папок файловой системы
(рисунок 3-5), в котором необходимо выбрать папку импортируемого проекта. В нашем случае, это долж-
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Рисунок 3-4: Окно импорта проекта

на быть папка «D:/SRIO/benchmark/SRIO_TputBenchmarkingTestProject-Cons». После выбора нужной папки,
нажмите кнопку «OK».

Рисунок 3-5: Системное окно выбора папок файловой системы
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Если папка с проектом выбрана верно, в окне импорта проекта должен появиться проект «SRIO_-
TputBenchmarkingTestProject-Cons» в списке проектов, доступных для импорта (рисунок 3-6). Снимите фла-
жок с параметра «Copy projects into workspace» (если он установлен) и нажмите кнопку «Finish».

Рисунок 3-6: Окно импорта проекта

3.1.3 Сборка проекта

В левой части главного окна находится окно «Project Explorer», в котором должен находиться только один
проект «SRIO_TputBenchmarkingTestProject-Cons». Нажмите правой кнопкой мыши на названии проекта и
в появившемся меню выберите пункт «Build Project» (рисунок 3-7).

Примечание

Если окно «Project Explorer» не появилось, его можно открыть, выбрав пункт меню «View > Project Explorer».

Примечание

Сборку проекта можно выполнить путем выбора пункта главного меню «Project > Build Project».

Будет запущен процесс сборки проекта, ход которого будет отображаться в окне, показанном на рисунке 3-8.

В случае успешной сборки, в окне консоли (Console) должны быть выведены сообщения, идентичные пока-
занным на рисунке 3-9.

Примечание

Если окна консоли нету, его можно открыть, выбрав пункт меню «View > Console».
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Рисунок 3-7: Пункт меню для сборки проекта

Рисунок 3-8: Окно, отображающее ход процесса сборки проекта

Рисунок 3-9: Окно, отображающее ход процесса сборки проекта
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3.2 Сборка проекта генератора (producer)
Для сборки проекта генератора данных теста производительности потребуется запуск второй копии среды
разработки CCS с отдельным рабочим пространством.

Запустите вторую копию среды разработки CCS. При запуске будет отображено окно выбора рабоче-
го пространства (см. рисунок 3-2). Введите в поле ввода «Workspace:» путь к рабочему пространству
(«D:/SRIO/Workspace_Prod») и нажмите на кнопку «OK». Будет создано новое рабочее пространство
«Workspace_Prod».

Далее, выполните импорт проекта генератора теста производительности из папки
«D:/SRIO/benchmark/SRIO_TputBenchmarkingTestProject-Prod» в новое рабочее пространство, как опи-
сано в разделе 3.1.2.

Выполните сборку проекта, аналогично действиями описанным в разделе 3.1.3.
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4 Конфигурация XDS100

Для загрузки и запуска теста производительности SRIO потребуется два модуля SAMC-403. Загрузка про-
грамм в память модулей осуществляется посредством эмулятора XDS100. Так как работа будет произво-
диться сразу с двумя отладчикам, система CCSдолжна идентифицировать каждое устройство. Идентифи-
кация устройств будет происходить по серийным номерам XDS100 эмуляторов на плате SAMC-403.

Перед выполнением нижеописанных действий, на обоих модулях SAMC-403 необходимо установить пе-
реключатели в соответствии с таблицей А-1 (см. приложение А), установить модули в шасси, подключить
отладчики XDS100 обоих модулей к компьютеру USB кабелями и включить модули.

В составе среды CCS имеется утилита, которая позволяет просматривать серийные номера подключенных
к системе эмуляторов XDS100. Для запуска утилиты запустите командную строку Windows1 и выполните в
ней следующие команды:

cd "C:\Program Files\Texas Instrumens\ccsv5\ccs_base\common\uscif"
xds100serial

Результатом выполнения данных команд будет вывод списка подключенных к системе эмуляторов XDS100
с их серийными номерами (рисунок 4-1).

Рисунок 4-1: Серийные номера, подключенных к системе, эмуляторов XDS100

В случае, если оба эмулятора XDS100 имеют одинаковые серийные номера, руководствуйтесь информа-
цией, приведенной в приложении Б, для изменения серийного номера одного из эмуляторов.

Далее, полученные серийные номера эмуляторов XDS100 необходимо привязать к целевым конфигура-
циям (Target Configuration) в проектах теста производительности. Для этого, в CCS, нужно выбрать пункт
меню «View > Target Configurations». В правой части главного окна откроется окно целевых конфигураций
«Target Configurations».

В этом окне, в дереве конфигураций, необходимо раскрыть узел «Projects», а в нем узел с на-
званием проекта («SRIO_TputBenchmarkingTestProject-Cons» для приемника данных и «SRIO_-
TputBenchmarkingTestProject-Prod» для генератора данных). В раскрытом узле прокта будет файл целевой
конфигурации проекта:

• «evm6678l-cons.ccxml» — конфигурация в проекте приемника данных;
• «evm6678l-prod.ccxml» — конфигурация в проекте генератора данных.

Для редактирования целевой конфигурации, щелкните двойным щелчком по ней в окне
«Target Configurations». Откроется окно редактирования целевой конфигурации, показанное на рисун-
ке 4-2.

1 Командную строку в Windows можно вызвать несколькими способами:
• нажатием сочетания клавиш Win+R и введя в появившемся окне команду cmd;
• выбрав пункт меню «Пуск > Выполнить...» и введя в появившемся окне команду cmd;
• выбрав пункт меню «Пуск > Все программы > Стандартная > Командная строка».
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Рисунок 4-2: Редактирование целевой конфигурации

В нижней части окна, нажмите на вкладку «Advanced» для перехода в режим редактирования дополни-
тельных параметров. В данном режиме, будет выведено дерево компонентов целевого устройства, в корне
которого расположен эмулятор XDS100 («Texas Instruments XDS100v1 USB Emulator_0»). Щелкните левой
кнопкой мыши по нему. В правой части будут выведены настраиваемые параметры эмулятора (рисунок 4-3).

Рисунок 4-3: Редактирование целевой конфигурации, параметры эмулятора XDS100
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Для возможности ввода серийного номера эмулятора XDS100, необходимо параметру «Emulator Selection»
установить значение «Select by serial number» и вписать в поле ввода «– Enter the serial number» серийный
номер требуемого эмулятора. После ввода серийного номера, нажмите на кнопку «Save».

При вводе серийных номеров эмуляторов XDS100 важно не ошибиться и ввести данные корректно. В це-
левую конфигурацию «evm6678l-cons.ccxml» необходимо вводить серийный номер эмулятора того модуля
SAMC-403 который будет работать в режиме приемника данных. Соответственно, в целевую конфигурацию
«evm6678l-prod.ccxml» необходимо вводить серийный номер эмулятора того модуля SAMC-403, который
будет работать в режиме генератора данных.

Примечание

Проверить правильность установки серийных номеров можно с помощью тестирования соединения с эмулятором
XDS100(кнопка «Test Connection» на рисунке 4-3), при отключенном одном из эмуляторов (достаточно отключить USB
кабель от одного из устройств). Выполнять тестирование можно только после сохранения конфигурации (кнопка «Save»).
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5 Загрузка и инициализация теста производительности

Для загрузки проектов теста производительности в память модулей SAMC-403 потребуется использовать
обе копии среды разработки CCS, которые были созданы в разделе 3.

Первая копия среды CCS с рабочим пространством «Workspace_Cons» используется для работы с моду-
лем SAMC-403, который будет работать в качестве приемника данных по шине SRIO. Вторая копия среды
CCS с рабочим пространством «Workspace_Prod» используется для работы со вторым модулем SAMC-403,
который будет работать в качестве генератора данных и передавать его на первый модуль по шине SRIO.

5.1 Запуск целевых конфигураций
Для запуска целевой конфигурации модуля SAMC-403, работающего в режиме приемника данных
(consumer), выполните действия, описанные в процедуре 5-1.

Процедура 5-1. Процедура подключения к модулю SAMC-403 (приемник данных)

1. Перейдите в копию CCS с рабочим пространством «Workspace_Cons».
2. Откройте окно «Target Configurations» (меню «View > Target Configurations»).
3. Нажмите на целевой конфигурации «evm6678l-cons.ccxml» правой кнопкой мыши. В появившемся

контекстном меню выберите пункт «Launch Selected Configuration» (рисунок 5-1а).

а) Приемник данных (consumer) б) Генератор данных (producer)

Рисунок 5-1: Запуск целевой конфигурации

Аналогично процедуре 5-1, для запуска целевой конфигруации модуля SAMC-403, работающего в режиме
генератора данных (producer), выполните действия, описанные в процедуре 5-2.

Процедура 5-2. Процедура подключения к модулю SAMC-403 (генератор данных)

1. Перейдите в копию CCS с рабочим пространством «Workspace_Prod».
2. Откройте окно «Target Configurations» (меню «View > Target Configurations»).
3. Нажмите на целевой конфигурации «evm6678l-prod.ccxml» правой кнопкой мыши. В появившемся

контекстном меню выберите пункт «Launch Selected Configuration» (рисунок 5-1б).
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5.2 Подключение к процессорам
Когда целевые конфигурации запущены, среда разработки CCS переходит в режим отладки, в котором
появляются дополнительные отладочные окна (рисунок 5-2).

Рисунок 5-2: Главное окно CCS в режиме отладки

5.2.1 Приемник данных

Для проекта приемника данных необходимо выполнить подключение к первому ядру процессора C6678.
В окне «Debug» выведен список ядер процессора C6678. Нажмите правую кнопку мыши на первом ядре
(самое верхнее). В появившемся контекстном меню выберите пункт «Connect Target» (рисунок 5-3).

При успешном выполнении подключения к ядру процессора C6678, в консоль должна быть выведена ин-
формация об инициализации ядра, как показано на рисунке 5-4.

5.2.2 Генератор данных

Для проекта генератора данных необходимо выполнить подключение к двум первым ядрам процессора
C6678. Для этого, первым делом, необходимо объединить эти ядра в группу. В окне «Debug» выведен спи-
сок ядер процессора C6678. Нужно выделить два первых ядра с помощью левой кнопки мыши с зажатой
клавишей Shift на клавиатуре. После чего, нажать правой клавишей мыши на выделенных ядрах и выбрать
пункт меню «Group сore(s)» (рисунок 5-5).

Нажмите правую кнопку мыши на появившейся группе ядер «Group 1». В появившемся контекстном меню
выберите пункт «Connect Target» (рисунок 5-6).

При успешном подключении, в консоль должна быть выведена информация об инициализации ядра, как
показано на рисунке 5-4.
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Рисунок 5-3: Подключение к ядру процессора C6678

Рисунок 5-4: Вывод в консоль при успешном подключении к ядру процессора C6678
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Рисунок 5-5: Группировка ядер процессора C6678

Рисунок 5-6: Подключение к группе ядер процессора C6678
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5.3 Загрузка программ
После выполнения подключения к ядрам процессора на обоих модулях, в память ядер необходимо загру-
зить собранные программы теста производительности (см. раздел 3.1.3). Для выполнения загрузки необхо-
димо нажать на кнопку загрузки программы (выделена красным кругом на рисунке 5-7).

Рисунок 5-7: Кнопка загрузки программы в память ядра

5.3.1 Приемник данных

Перейдите в копию среды разработки CCS с проектом приемника данных (consumer). Нажмите на кнопку
загрузки программ (см. рисунок 5-7). Откроется окно загрузки программы, показанное на рисунке 5-8, в
котором можно выбрать бинарный образ программы для загрузки.

Рисунок 5-8: Окно загрузки программы

Нажмите на кнопку «Browse project...». Откроется окно выбора бинарного образа программы для загруз-
ки (рисунок 5-9). В этом окне, в дереве проекта «SRIO_TputBenchmarkingTestProject-Cons» нужно выбрать
образ «SRIO_TputBenchmarkingTestProject-Cons.out» и нажать на кнопку «OK». В окне загрузки программы
(рисунок 5-8), также нажать на кнопку «OK».

Рисунок 5-9: Окно выбора бинарного образа программы для загрузки

Начнется процесс загрузки программы в память ядра процессора C6678. После завершения загрузки про-
граммы, окно «Debug», в котором отображается список ядер процессора C6678 примет вид, показанный на
рисунке 5-10.
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Рисунок 5-10: Окно «Debug» после загрузки программы

5.3.2 Генератор данных

Перейдите в копию среды разработки CCS с проектом генератора данных (producer). В окне «Debug» рас-
кройте группу «Group 1» из двух ядер и выберите второе ядро щелкнув по нему левой кнопкой мыши (рису-
нок 5-11).

Рисунок 5-11: Выбор второго ядра для загрузки программы генератора данных

Далее, нажмите на кнопку загрузки программ (см. рисунок 5-7). Откроется окно загрузки программы, пока-
занное на рисунке 5-8, в котором можно выбрать бинарный образ программы для загрузки.

Нажмите на кнопку «Browse project...». Откроется окно выбора бинарного образа программы для загруз-
ки (рисунок 5-8). В этом окне, в дереве проекта «SRIO_TputBenchmarkingTestProject-Cons» нужно выбрать
образ «SRIO_TputBenchmarkingTestProject-Cons.out» и нажать на кнопку «OK». В окне загрузки программы
(рисунок 5-8) также нажать на кнопку «OK».

Начнется процесс загрузки программы в память ядра процессора C6678. После завершения загрузки про-
граммы, окно «Debug», в котором отображается список ядер процессора C6678 примет вид, показанный на
рисунке 5-12.
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Рисунок 5-12: Окно «Debug» после загрузки программы
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6 Запуск теста производительности

Перед выполнением процедуры запуска теста производительности на модулях SAMC-403 необходимо вы-
полнить действия, описанные в разделах 3 и 5. Сборку программ приемника и генератора данных (раздел 3)
достаточно выполнить один раз.

Внимание

Для успешного запуска теста производительности оба модуля SAMC-403 должны быть установлены в
правильные AMC-слоты в соответствии с конфигурацией коммутатора SMCH-100-SRIO12. Правильная
установка модулей и конфигурация коммутатора SMCH-100-SRIO12 рассмотрены в разделе 4.

Сначала запускается программа приемника данных (consumer). Для запуска программы необходимо перей-
ти в копию среды разработки CCS с рабочим пространством «Workspace_Cons» и нажать на кнопку запуска
программы (выделена красным кругом на рисунке 6-1).

Рисунок 6-1: Кнопка запуска программы

При успешном запуске программы, среди прочих отладочных сообщений в консоль должно быть выведено:
Debug: SRIO port 0 is operational.

После запуска программы приемника данных, нужно запустить программу генератора данных (producer).
Для этого, в соответствующей копии среды CCS, нажмите на кнопку запуска программы (см. рисунок 6-1).
При успешном запуске программы, среди прочих отладочных сообщений в консоль должно быть выведено:

Debug: SRIO port 0 is operational.

После запуска программы генератора начнется передача данных на модуль с запущенной программой при-
емника данных. Ход выполнения теста производительности будет выводится в консоль обоих модулей.

Пример вывода в консоль программы приемника данных показан на рисунке 6-2.

Пример вывода в консоль программы генератора данных показан на рисунке 6-3.

Полные листинги вывода программ приемника (consumer) и генератора (producer) данных теста производи-
тельности приведены в приложении В.
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Рисунок 6-2: Вывод в консоль при программы приемника данных (consumer)

Рисунок 6-3: Вывод в консоль при программы генератора данных (producer)
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Приложение А Аппаратная конфигурация

Таблица А-1: Положение переключателей модуля SAMC-403 для включения режима работы с PCI-E

Переключатель 1 2 3 4
SW3 OFF ON ON ON

SW4 ON ON ON ON

SW5 ON ON ON ON

SW6 ON ON ON ON

Соответствие номеров AMC-слотов в 1U шасси производства компании MicroBlade с их физическим распо-
ложением в шасси показано на рисунке А-1.

Рисунок А-1: Расположение AMC-слотов в шасси MicroBlade 1U

Соответствие номеров AMC-слотов в 2U шасси производства компании MicroBlade с их физическим распо-
ложением в шасси показано на рисунке А-2.

Рисунок А-2: Расположение AMC-слотов в шасси MicroBlade 2U

Соответствие номеров AMC-слотов в 2U шасси BluTwo! производства компании ELMA с их физическим
расположением в шасси показано на рисунке А-3.

Рисунок А-3: Расположение AMC-слотов в шасси ELMA BluTwo!

Коммутатор SMCH-100-SRIO12 имеет две микросхемы SRIO коммутатора TSI578. Каждая из микросхем
управляется 4-х позиционными переключателями S3 и S5. Описание значений этих 4-х позиционных пере-
ключателей описано в таблицах А-2, А-3 и А-4.
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Таблица А-2: Описание значений переключателей для установки скорости портов Serial RapidIO

S:2 S:1 Скорость портов Serial RapidIO
ON ON 1.25 Гбит/с

ON OFF 2.5 Гбит/с

OFF ON 3.125 Гбит/с

OFF OFF Зарезервировано

Таблица А-3: Описание значений переключателей для установки режима загрузки с EEPROM

S:3 Режим загрузки с EEPROM
ON Загрузка из нижней части EEPROM (0–64 КБайт)

OFF Загрузка из верхней части EEPROM (64–128 КБайт)

Таблица А-4: Описание значений переключателей для установки режима защиты от изменения EEPROM

S:4 Защита от изменения содержимого EEPROM
ON Изменение содержимого EEPROM заблокировано

OFF Изменение содержимого EEPROM разрешено

В коммутаторе SMCH-100-SRIO12 маршрутизация пакетов SRIO в направлении конкретного AMC-слота
осуществляется в зависимости от идентификатора получателя (ID), содержащегося в пакете. Соответствие
идентификаторов получателя и номеров AMC-слотов приведено в таблице А-5.

Таблица А-5: Соответствие идентификаторов получателя номерам AMC-слотов

Номер AMC-слота Идентификатор получателя
1 0x10–0x1F

2 0x20–0x2F

3 0x30–0x3F

4 0x40–0x4F

5 0x50–0x5F

6 0x60–0x6F

7 0x70–0x7F

8 0x80–0x8F

9 0x90–0x9F

10 0xA0–0xAF

11 0xB0–0xBF

12 0xC0–0xCF
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Приложение Б Изменение серийного номера XDS100

Для изменения серийного номера эмулятора XDS100 используется программа FTDI FT Prog. Програм-
му FTDI FT Prog версии 2.6.8 можно найти на сопроводительном диске к модулю SAMC-403 в папке
«software/ftdi». Скачать последнюю версию программу можно по ссылке http://www.ftdichip.com/Resources/
Utilities.htm.

Запустите программу FTDI FT Prog. В открывшемся главном окне выберите пункт меню
«Devices > Scan and Parse» или нажмите клавишу F5. Будет выполнено чтение информации из EEPROM
всех доступных устройств XDS100.

После выполнение чтения данных из EEPROM устройств, раскройте узел «USB String Descriptors»
одного из устройств, например, устройство «Device: 0» (рисунок Б-1). Выберите в раскрытом узле
«USB String Descriptors» параметр «SerialNumber».

Рисунок Б-1: Главное окно программы FTDI FT Prog

В правой части окна программы FTDI FT Prog будет отображена текущая информация о серийном номере
устройства. Для его изменения, снимите флажок с параметра «Auto Generate Serial No:», и впишите в поле
ввода «Serial Number:» значение нового серийного номера устройства.

Для записи измененной информации обратно в EEPROM устройства, выберите пункт меню
«Devices > Program» или нажмите сочетание клавиш Ctrl+P.

После завершения записи в устройство, для применения сделанных изменений, необходимо выключить
устройство и снова включить.
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Приложение В Листинги вывода программ теста
производительности

Вывод программы генератора данных (producer) теста производительности:
[C66xx_1] ********************************
[C66xx_1] *********** PRODUCER ***********
[C66xx_1] ********************************
[C66xx_1] WARNING: Please ensure that the CONSUMER is executing before running the PRODUCER!!
[C66xx_1] Debug: Waiting for module reset...
[C66xx_1] Debug: Waiting for module local reset...
[C66xx_1] Debug: Waiting for SRIO ports to be operational...
[C66xx_1] Debug: SRIO port 0 is operational.
[C66xx_1] Debug: Lanes status shows lanes formed as one 4x port
[C66xx_1] Debug: AppConfig Tx Queue: 0x2a0 Flow Id: 0
[C66xx_1] Debug: SRIO Driver Instance 0x@00861c10 has been created
[C66xx_1] Debug: Running test in polled mode.
[C66xx_1] Debug: SRIO Driver handle 0x861c10.
[C66xx_1]
[C66xx_1]
[C66xx_1] Debug: Running test. The passage - 1
[C66xx_1] Latency: (DIO_NW, 3.125GBaud, 4X, tab delimited)
[C66xx_1] Core Lanes Speed Conn MsgType PktSize NumPkts MnLCycs AgLCycs MxLCycs
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 4 100 1321 1361 1427
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 8 100 1321 1355 1380
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 16 100 1378 1379 1396
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 32 100 1436 1436 1453
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 64 100 1551 1552 1568
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 128 100 1781 1781 1803
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 256 100 2241 2242 2266
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 512 100 2471 2480 2529
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 1024 100 2988 2989 3013
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 2048 100 3966 3967 3990
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 4096 100 5863 5902 5923
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 8192 100 9773 9776 9832
[C66xx_1]
[C66xx_1] Throughput: (TX side, DIO_NW, 3.125GBaud, 4X, tab delimited)
[C66xx_1] Core Lanes Speed Conn MsgType OHBytes PktSize Pacing Thruput PktsSec. NumPkts PktLoss AgPCycs AgLCycs AgICycs AgOCycs Seconds
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 16 4 0 39.95 1248439.50 6000000 No 801 667 81 53 4.81
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 16 8 0 79.90 1248439.50 6000000 No 801 667 81 53 4.81
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 16 16 0 159.80 1248439.50 6000000 No 801 667 81 53 4.81
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 16 32 0 319.60 1248439.50 6000000 No 801 667 81 53 4.81
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 16 64 0 639.20 1248439.50 6000000 No 801 667 81 53 4.81
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 16 128 0 1278.40 1248439.50 6000000 No 801 667 81 53 4.81
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 16 256 0 2556.80 1248439.50 6000000 No 801 667 81 53 4.81
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 16 512 0 5113.61 1248439.50 6000000 No 801 667 81 53 4.81
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 16 1024 108 8102.87 989119.69 4800000 No 1011 668 290 53 4.85
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 16 2048 1050 8389.15 512032.78 2600000 No 1953 667 1233 53 5.08
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 16 4096 3020 8357.05 255036.98 1400000 No 3921 667 3201 53 5.49
[C66xx_1] 1 4 3.125 B-S-B DIO_NW 16 8192 6915 8382.71 127909.95 800000 No 7818 669 7096 53 6.25
[C66xx_1]
[C66xx_1] Latency: (DIO_NR, 3.125GBaud, 4X, tab delimited)
[C66xx_1] Core Lanes Speed Conn MsgType PktSize NumPkts MnLCycs AgLCycs MxLCycs
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 4 100 1869 1869 1933
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 8 100 1869 1870 1977
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 16 100 1869 1931 1977
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 32 100 1869 1977 2016
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 64 100 1869 2085 2119
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 128 100 1869 2303 2409
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 256 100 1869 2830 2842
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 512 100 1869 3057 3097
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 1024 100 1869 3494 3597
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 2048 100 1869 4465 4569
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 4096 100 1869 6420 6513
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 8192 100 1869 10308 10401
[C66xx_1]
[C66xx_1] Throughput: (TX side, DIO_NR, 3.125GBaud, 4X, tab delimited)
[C66xx_1] Core Lanes Speed Conn MsgType OHBytes PktSize Pacing Thruput PktsSec. NumPkts PktLoss AgPCycs AgLCycs AgICycs AgOCycs Seconds
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 28 4 0 21.67 677048.06 3400000 No 1477 666 757 54 5.02
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 28 8 0 43.33 677048.06 3400000 No 1477 666 757 54 5.02
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 28 16 0 86.66 677048.06 3400000 No 1477 666 757 54 5.02
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 28 32 0 162.33 634115.44 3200000 No 1577 666 857 54 5.05
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 28 64 0 305.49 596658.69 3000000 No 1676 666 956 54 5.03
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 28 128 0 534.17 521648.41 2600000 No 1917 666 1197 54 4.99
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 28 256 0 870.01 424808.84 2200000 No 2354 666 1634 54 5.18
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 28 512 0 1577.81 385208.00 2000000 No 2596 666 1876 54 5.19
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 28 1024 0 2655.43 324149.09 1800000 No 3085 666 2365 54 5.55
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 28 2048 0 4010.77 244798.05 1400000 No 4085 666 3365 54 5.72
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 28 4096 0 5448.62 166278.69 1000000 No 6014 666 5294 54 6.01
[C66xx_1] 1 4 3.125 B-S-B DIO_NR 28 8192 0 6627.16 101122.46 600000 No 9889 666 9169 54 5.93
[C66xx_1]
[C66xx_1] Latency: (Type-11, 3.125GBaud, 4X, tab delimited)
[C66xx_1] Core Lanes Speed Conn MsgType PktSize NumPkts MnLCycs AgLCycs MxLCycs
[C66xx_1] 1 4 3.125 B-S-B Type-11 16 100 3073 3140 3218
[C66xx_1] 1 4 3.125 B-S-B Type-11 32 100 3073 3168 3267
[C66xx_1] 1 4 3.125 B-S-B Type-11 64 100 3211 3311 3405
[C66xx_1] 1 4 3.125 B-S-B Type-11 128 100 3487 3581 3687
[C66xx_1] 1 4 3.125 B-S-B Type-11 256 100 4039 4061 4238
[C66xx_1] 1 4 3.125 B-S-B Type-11 512 100 4177 4280 4374
[C66xx_1] 1 4 3.125 B-S-B Type-11 1024 100 4592 4728 4874
[C66xx_1] 1 4 3.125 B-S-B Type-11 2048 100 5694 5699 5833
[C66xx_1] 1 4 3.125 B-S-B Type-11 4096 100 7627 7688 7766
[C66xx_1]
[C66xx_1] Throughput: (TX side, Type-11, 3.125GBaud, 4X, tab delimited)
[C66xx_1] Core Lanes Speed Conn MsgType OHBytes PktSize Pacing Thruput PktsSec. NumPkts PktLoss AgPCycs AgLCycs AgICycs AgOCycs Seconds
[C66xx_1] 1 4 3.125 B-S-B Type-11 24 16 887 63.21 493827.16 2600000 No 2025 392 1556 77 5.27
[C66xx_1] 1 4 3.125 B-S-B Type-11 24 32 887 126.42 493827.16 2600000 No 2025 392 1556 77 5.27
[C66xx_1] 1 4 3.125 B-S-B Type-11 24 64 887 252.84 493827.16 2600000 No 2025 392 1556 77 5.27
[C66xx_1] 1 4 3.125 B-S-B Type-11 24 128 887 505.68 493827.16 2600000 No 2025 392 1556 77 5.27
[C66xx_1] 1 4 3.125 B-S-B Type-11 24 256 887 1011.36 493827.16 2600000 No 2025 392 1556 77 5.27
[C66xx_1] 1 4 3.125 B-S-B Type-11 24 512 887 2022.72 493827.16 2600000 No 2025 392 1556 77 5.27
[C66xx_1] 1 4 3.125 B-S-B Type-11 24 1024 887 4045.43 493827.16 2600000 No 2025 392 1556 77 5.27
[C66xx_1] 1 4 3.125 B-S-B Type-11 24 2048 887 8090.86 493827.16 2600000 No 2025 392 1556 77 5.27
[C66xx_1] 1 4 3.125 B-S-B Type-11 24 4096 0 8421.49 257003.34 1400000 No 3891 392 3422 77 5.45
[C66xx_1]
[C66xx_1] Debug: End of test. The passage - 1
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Вывод программы приемника данных (consumer) теста производительности:
[C66xx_0] ********************************
[C66xx_0] *********** CONSUMER ***********
[C66xx_0] ********************************
[C66xx_0] WARNING: Please ensure that the CONSUMER is executing before running the PRODUCER!!
[C66xx_0] Debug: Waiting for module reset...
[C66xx_0] Debug: Waiting for module local reset...
[C66xx_0] Debug: Waiting for SRIO ports to be operational...
[C66xx_0] Debug: SRIO port 0 is operational.
[C66xx_0] Debug: Lanes status shows lanes formed as one 4x port
[C66xx_0] Debug: AppConfig Tx Queue: 0x2a0 Flow Id: 0
[C66xx_0] Debug: SRIO Driver Instance 0x@00861d00 has been created
[C66xx_0] Debug: Running test in polled mode.
[C66xx_0] Debug: SRIO Driver handle 0x861d00.
[C66xx_0]
[C66xx_0]
[C66xx_0] Debug: Running test. The passage - 1
[C66xx_0] Throughput: (RX side, DIO_NW, 3.125GBaud, 4X, tab delimited)
[C66xx_0] Core Lanes Speed Conn MsgType OHBytes PktSize Pacing Thruput PktsSec. NumPkts PktLoss AgPCycs AgLCycs AgICycs AgOCycs Seconds
[C66xx_0] 0 4 3.125 B-S-B DIO_NW 16 4 0 40.00 1250000.00 6000000 No 800 55 745 0 4.81
[C66xx_0] 0 4 3.125 B-S-B DIO_NW 16 8 0 80.00 1250000.00 6000000 No 800 55 745 0 4.81
[C66xx_0] 0 4 3.125 B-S-B DIO_NW 16 16 0 160.00 1250000.00 6000000 No 800 55 745 0 4.81
[C66xx_0] 0 4 3.125 B-S-B DIO_NW 16 32 0 320.00 1250000.00 6000000 No 800 55 745 0 4.81
[C66xx_0] 0 4 3.125 B-S-B DIO_NW 16 64 0 640.00 1250000.00 6000000 No 800 55 745 0 4.81
[C66xx_0] 0 4 3.125 B-S-B DIO_NW 16 128 0 1280.00 1250000.00 6000000 No 800 55 745 0 4.81
[C66xx_0] 0 4 3.125 B-S-B DIO_NW 16 256 0 2560.00 1250000.00 6000000 No 800 55 745 0 4.81
[C66xx_0] 0 4 3.125 B-S-B DIO_NW 16 512 0 5120.00 1250000.00 6000000 No 800 55 745 0 4.81
[C66xx_0] 0 4 3.125 B-S-B DIO_NW 16 1024 0 8110.89 990099.00 4800000 No 1010 55 955 0 4.85
[C66xx_0] 0 4 3.125 B-S-B DIO_NW 16 2048 0 8393.44 512295.09 2600000 No 1952 55 1897 0 5.08
[C66xx_0] 0 4 3.125 B-S-B DIO_NW 16 4096 0 8359.18 255102.05 1400000 No 3920 55 3865 0 5.49
[C66xx_0] 0 4 3.125 B-S-B DIO_NW 16 8192 0 8383.78 127926.31 800000 No 7817 55 7762 0 6.25
[C66xx_0]
[C66xx_0] Throughput: (RX side, Type-11, 3.125GBaud, 4X, tab delimited)
[C66xx_0] Core Lanes Speed Conn MsgType OHBytes PktSize Pacing Thruput PktsSec. NumPkts PktLoss AgPCycs AgLCycs AgICycs AgOCycs Seconds
[C66xx_0] 0 4 3.125 B-S-B Type-11 24 16 0 63.21 493827.16 2600000 No 2025 1575 90 360 5.27
[C66xx_0] 0 4 3.125 B-S-B Type-11 24 32 0 126.42 493827.16 2600000 No 2025 1575 90 360 5.27
[C66xx_0] 0 4 3.125 B-S-B Type-11 24 64 0 252.84 493827.16 2600000 No 2025 1575 90 360 5.27
[C66xx_0] 0 4 3.125 B-S-B Type-11 24 128 0 505.68 493827.16 2600000 No 2025 1575 90 360 5.27
[C66xx_0] 0 4 3.125 B-S-B Type-11 24 256 0 1011.36 493827.16 2600000 No 2025 1575 90 360 5.27
[C66xx_0] 0 4 3.125 B-S-B Type-11 24 512 0 2022.72 493827.16 2600000 No 2025 1576 88 361 5.27
[C66xx_0] 0 4 3.125 B-S-B Type-11 24 1024 0 4045.43 493827.16 2600000 No 2025 1582 82 361 5.27
[C66xx_0] 0 4 3.125 B-S-B Type-11 24 2048 0 8090.86 493827.16 2600000 No 2025 1595 70 360 5.27
[C66xx_0] 0 4 3.125 B-S-B Type-11 24 4096 0 8421.49 257003.34 1400000 No 3891 1590 1940 361 5.45
[C66xx_0]
[C66xx_0] Debug: End of test. The passage - 1
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